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For all variants: 

NDC-4, NDC-4-USB, NDC-4-ASW
NDC-4-AIS, NDC-4-AIS-USB

Full User Manual

Issue 1.09

 Multiple talker interface for use with the NMEA 0183 standard. Serial data 
networking of marine electronic devices / instruments. 

 RS232 & USB 1.1, 2.0 & 3.0 PC interfaces to the NMEA 0183 standard.

 Actisense ISO-Drive technology for a fully isolated serial data system.

	 Intelligent	NMEA	filtering	on	all	inputs	allows	smart	removal	of	NMEA	data.

	 Re-configurable	to	work	as	an	NDC-4-ASW	Autoswitch	to	allow	the	automatic	
switching	between	up	to	4	NMEA	inputs.
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Important Notices
Actisense and the Actisense logo are registered 
trademarks of Active Research Limited. All rights are 
reserved.	 The	 contents	 of	 this	 manual	 may	 not	 be	
transferred or copied without the express written 
permission of Active Research Limited. All other 
trademarks are the property of their respective owners. 

The Actisense	 NMEA	 Data	 Multiplexer	 /	 Combiner	 /	
Autoswitch (NDC-4) is intended for use in a marine 
environment,	primarily	for	below	deck	use.	If	the	unit	is	to	
be	used	in	a	more	severe	environment,	such	use	may	be	
considered misuse under the seller’s guarantee.

The Actisense	NDC-4	has	been	certified	to	comply	with	
the	European	directive	 for	Electromagnetic	Compatibility	
(EN60945), and is appropriately CE marked.  Operation of 
the	 unit	 should	 be	 in	 conjunction	 with	 appropriate	 CE	
approved	 shielded	 connectors	 and	 cabling	 used	 in	
accordance with the CE directive EN60945.  Any EMC 
related	 issues	 should	 be	 reported	 to	 Active Research 
Limited immediately to allow the company to rectify or 
resolve	 EMC	 related	 problems	 in	 accordance	 with	 its	
obligations	under	EN60945.

If the unit is connected such that compliance failure occurs 
beyond	the	company’s	control,	the	company	shall	not	be	
held	responsible	for	compliance	failure	until	suitable	EMC	
guidelines	for	connection	are	seen	to	have	been	taken.

Notices
The	 products	 and	 specifications	 described	 in	 this	 guide	
may	be	changed	without	prior	notice.	To	obtain	the	latest	
information visit www.actisense.com.

Active Research Limited	will	not	be	liable	for	infringement	
of copyright, industrial property right, or other rights of a 
third	party	caused	by	 the	use	of	 information	or	drawings	
described	in	this	manual.

The	 NDC-4	 must	 be	 used	 in	 accordance	 with	 the	
manufacturers instructions. Active Research Limited will 
not	be	held	responsible	for	any	damage	or	injury,	direct	or	
otherwise, as a result of failure to adhere to these 
instructions.

The NDC-4 does not validate the NMEA data it receives in 
any way. Neither the NMEA sentence checksum, nor the 
data contained within the NMEA sentence is validated. 
Therefore, the electronic device(s) supplying the NDC-4 
with	 NMEA	 data	 retain(s)	 the	 sole	 responsibility	 for	 the	
NMEA data’s validity.

Foreword
Actisense recognises that instructions are often skipped, 
so we have aimed to write this document in an informative, 
yet direct manner that will aid the user. We have tried to 
cover all the points a typical user may need to know.  
Please	 read	 all	 sections	 before	 installing	 and	 using	 the	
Actisense NMEA Data Multiplexer product and any 
related software programs.

Introduction
The Actisense NDC product range developed out of the 
requirement	 to	solve	 two	 fundamental	problems	with	 the	
existing marine industry NMEA 0183 communications 
standard. 

In	 theory,	 the	 NMEA	 0183	 standard	 allows	 any	 suitably	
designed marine electronic device to share its gathered 
information with any other device on a vessel. 
Unfortunately,	 there	 is	one	very	 large	drawback	with	 this	
standard - only one device on a connected network can 
actually send data (a single talker), with multiple devices 
(determined	 by	 the	 current	 limit	 of	 the	 sending	 unit)	
listening to that data (multiple listeners). 

If the vessel owner has an instrument that ideally requires 
the data output of two or more devices, for example a 
chart-plotter,	 then	 the	 owner	 has	 no	 alternative	 but	 to	
settle on connecting only the most important device (that 
which supplies the most used information), normally that is 
the	GPS	unit.	All	other	devices	cannot	be	used.

What happens if the owner prefers the vessels gyro 
compass heading output to that of the GPS, or requires 
that	the	current	depth	be	displayed	on	the	plotted	chart	to	
help	avoid	the	possible	case	of	running	the	vessel	aground	
on	a	shifting	sand	bank?	The	NMEA	0183	standard	cannot	
supply an answer to those questions as it can handle only 
one transmitting device.

These	two	elementary	problems	can	be	solved	simply	and	
easily with the Actisense NMEA Data Multiplexer’s very 
flexible	design	approach.

Alternately, if the vessel has two or more identical NMEA 
devices (e.g. GPS’s or depth sounders) the system 
solution	could	be	to	use	the	NDC-4	as	an	NMEA	Autoswitch	
to select the highest priority source.

Full information on the complete Actisense product range 
can	be	found	on	the Actisense website (www.actisense.
com).

http://www.actisense.com
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General Features
4/5 Opto-isolated Input Ports
Each Opto-isolated input port has a priority level. This 
defaults	 to	 the	 logical	 order	matching	 the	 port	 numbers,	
i.e. port 1 has the highest priority and port 4 has the lowest. 
When	the	USB	cable	is	not	plugged	in	(or	not	powered),	
OPTO	IN	0	can	be	used	as	a	fifth	 fully	compliant	NMEA	
0183 data input, appearing last in the priority list.

2 ISO-Drive Output Ports
These	outputs	combine	the	input	data	into	standard	NMEA	
outputs with independent Baud rate selection options, 
defaulting to 4800 (OUT 1) and 38400 (OUT 0). If the 
combined	Baud	rate	of	all	NMEA	inputs	exceed	the	output	
Baud	 rate,	 it	 is	 possible	 that	 the	 combined	 data	 could	
exceed the data carrying capacity of the NMEA output 
channel. The multiplexer contains special software to 
ensure that when the output channel is overloaded, new 
data	of	the	same	type	as	older	data,	still	in	the	buffer,	will	
overwrite the older sentence. 

A PC RS232 or USB Bidirectional Port
The	RS232	compatible	Port	0	(OPTO	IN	0	plus	ISO	OUT	
0) and the USB interface ensures that any device (or PC), 
that has an RS232 or USB port, receives all the input 
NMEA data, and can add its own NMEA data to ISO OUT 
1.	 This	 allows	 for	 the	 possibility	 of	 a	 “virtual	 cockpit”	 of	
instruments	displaying	all	available	data	in	any	manner	the	
user	requires	(available	from	a	number	of	manufacturers).	

These	connections	also	allow	 the	unit	 to	be	updated	via	
the	freely	available	ActiPatch	flash	upgrade	software	that	
will	be	made	available	on	the	Actisense	website	when	the	
NDC-4	firmware	has	been	enhanced.

Notes:
1. When	the	USB	cable	is	plugged	in	and	powered	up,	it	
disables	OPTO	IN	0	on	the	NDC-4.
2. NDC-4	variants	that	don’t	come	with	a	USB	cable	can	
be	upgraded	by	purchasing	a	USB	Upgrade	Kit.

Technical Features
Flash ROM technology that supports automatic 
programming for quick and easy updates, 100,000+ erase 
cycles and a 10 year Data Retention provides carefree 
user	configuration.	

On-chip memory store	 allows	 buffering	 of	 short-term	
NMEA data, allowing the unit to smooth short-term peaks 
in	the	NMEA	data	flow.

A diagnostic LED indicates the operation mode of the 
NDC-4,	if	any	faults	have	been	detected,	or	the	peak	load	
currently on any one of the NMEA inputs. 
High-speed 32-bit ARM processor	capable	of	up	to	40	

million instructions per second.

The NMEA 0183 inputs are galvanically opto-isolated 
differential inputs, protecting against common mode 
voltage differences of up to 2500v. Fully compliant with the 
NMEA	 0183	 standard	 specification	 and	 compatible	 with	
RS232, RS422 and RS485 signal levels. The typical 
operating voltage is 2.0v to 15.0v and can withstand +/- 
35v	continuously	and	+/-	40v	transients.	Compatible	with	
both	differential	and	single	ended	inputs.	

ISO-Drive output technology unique to Actisense, 
protects against common mode voltage differences of up 
to	 1500v.	 The	 output	 automatically	 changes	 between	
differential and single ended drive depending upon the 
type of instrument it is connected to. Fully compliant with 
the	 NMEA	 0183	 standard	 specification	 and	 compatible	
with RS232, RS422 and RS485 signal levels.

Wide battery input voltage range to offer maximum 
compatibility,	the	NMEA	0183	NDC-4	can	operate	from	a	
battery	supply	anywhere	between	8	and	35	volts.

USB powered	option	is	available	when	the	battery	source	
is	not	present.	When	the	main	battery	is	present,	the	USB	
power drain is minimal. WARNING:	The	USB	and	battery	
grounds are not isolated, see “USB Warning” on page 11.

Very tough Polycarbonate case	 is	 certified	 to	 IP66		
(Protection	against	heavy	seas,	or	powerful	jets	of	water),	
the	 addition	 of	 non-acid	 based	 marine	 sealant	 to	 the	
gasket can increase this to IP67 (Protection against 
immersion).	 Being	 Polycarbonate,	 it	 is	 also	 incredibly	
strong, offering a wide temperature range and superior 
protection to the electronics inside. 

Robust Nylon grommets	are	certified	to	IP68	(Protection	
against	complete,	continuous	submersion	in	water).
Note: To achieve this level of water integrity all glands 
must	 be	 occupied	 by	 round-section	 cables	 of	 between	
4.5mm	and	10	mm	or	be	replaced	by	blanking	plugs.

Large range of possible cable diameters	 of	 between	
4.5	mm	and	10	mm,	single	or	multi-pair	wire	types	can	be	
easily accepted.

An NMEA 0183 Checksum will	be	added	to	any	sentence	
received	without	one	to	ensure	that	they	can	be	accepted	
by	an	NMEA	0183	Listener	that	expects	a	checksum.		This	
feature makes the NDC-4 essential even when interfacing 
a	single	v.1.5	NMEA	0183	Talker	 to	a	v.2.0	 (and	above)	
NMEA 0183 Listener.
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Software Updates
The	 NDC’s	 built-in	 firmware	 is	 held	 in	 ‘flash’ memory, 
allowing quick and easy upgrades using a simple Microsoft 
Windows™ NT/2000/XP/Vista/7 user interface program 
(ActiPatch) running on a connected PC.
It is our policy to provide these updates free on the 
Actisense website (www.actisense.com). This upgrade 
can	be	performed	with	the	unit	completely	in-situ,	via	a	PC	
connected to either Port 0 (OPTO IN 0 and ISO OUT 0) or 
the USB port.

Connecting devices together
The Basics
NMEA data is transmitted from an information source such 
as GPS, depth sounder, gyro compass etc. These data 
sending devices are called “Talkers”.

Equipment receiving this information such as a chart-
plotter, radar or NMEA display is called a “Listener”. 

Unfortunately,	only	one	Talker	can	be	connected	on	 to	a	
single NMEA 0183 system at any one time. Two or more 
Talkers	 are	 simply	 not	 possible	 because	 they	 are	 not	
synchronised to each other, and will attempt to ‘talk’ at the 
same time (over each other), resulting in corruption of the 
NMEA	 data,	 and	 potentially	 in	 disaster	 if	 valuable	 data	
such as navigation information is lost or corrupted so that 
it is incorrect and/or misleading.

Actisense produces a full range of products to solve all 
NMEA interfacing requirements.

Please visit the Actisense website (www.actisense.
com) for full details on these and other Actisense 
interfacing, Depth sounding and NMEA 2000 products.

The NMEA Signals
The	NMEA	0183	system	v2.0	and	later	uses	a	”differential”	
signalling	scheme,	whereby	two	wires	are	used	to	transmit	
the	 NMEA	 data.	 These	 connections	 will	 be	 labelled	 as	
either NMEA ‘A’ and ‘B’ or NMEA ’+’ and ‘-’ respectively, 
depending on the instrument and manufacturer.

When	connecting	between	different	manufacturers,	there	
can	 be	 some	 confusion,	 but	 it	 is	 simple	 and	 easy	 to	
remember:	NMEA	‘A’ connects to NMEA ‘+’ and NMEA ‘B’ 
connects to NMEA ‘-’.

The Different NMEA Standards
The	NMEA	0183	specification	has	slowly	evolved	over	the	
years, so connecting one device to another is not always a 
straightforward matter. The earlier versions of NMEA 0183 
(before	 v2.0,	 as	 detailed	 above),	 used	 slightly	 different	
connection methods and signal levels: the instruments 
had	just	one	“NMEA”	data	line	(‘Tx’	or	‘Out’),	and	used		the	
ground as the other line - similar to the way a computer 
serial port works. This connection method is referred to as 
“single	ended”	instead	of	the	“differential”	method	used	by	
NMEA 0183 v2.0 devices.

The	data	format	is	largely	the	same	between	both	systems,	
with v2.0 adding some extra sentence strings, and 
removing older (redundant) sentence strings from the 
specification.	The	situation	is	further	complicated,	as	many	
manufacturers	still	use	the	old	(“single	ended”)	method	of	
connection	because	it	is	cheaper	to	implement.

So	how	can	an	older	type	NMEA	device	be	connected	to	a	
newer	type	device?

Care	is	needed	–	it	is	possible	to	damage	or	overload	the	
output of a newer differential device if it is incorrectly 
connected	 to	an	older	device.	This	 is	because	 the	older	
devices used ground as the return, whereas the newer 
devices actually drive the NMEA ‘-/B’	line	between	5v	and	
0v. Thus, connecting this output to ground will result in 
high	 currents	 being	 drawn	 by	 the	 driver	 instrument,	
resulting in potential overheating and damage to the driver 
circuits.

However, the new Actisense ISO-Drive technology allows 
the	 user	 not	 to	 worry	 about	 this	 potentially	 damaging		
incompatibility.	 Instead,	 an	 ISO-Drive	 output	 can	 be	
connected	 to	 an	 old	 type	 single-ended	 system,	 by	
connecting the NMEA ‘+/A’ output from the ISO-Drive to 
the single-ended NMEA ‘Rx’	 or	 “In”	 input	 of	 the	 device.	
Connect the NMEA ‘-/B’ output of the ISO-Drive to the 
ground of the single-ended device. This provides the 
required data signal return current path.

To connect an old type single-ended device to an OPTO 
IN input, connect the NMEA ‘Tx’ or ‘Out’ output from the 
single-ended driver to the OPTO IN ‘+/A’ input of the NDC-
4. Connect the ground line of the single-ended output 
device to the OPTO IN ‘-/B’ input of the NDC-4. This 
provides the data signal return current path. If the NMEA 
‘-/B’	input	is	left	floating,	then	data	corruption	/	errors	may	
occur.

Please refer to “Connecting to NMEA devices” on page 
10 for examples of these connection methods.

www.actisense.com
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1. Five Opto-isolated Inputs.
All inputs are of the differential opto-isolated type and use 
the unique Actisense low current drain circuitry (2mA @ 
2.0v) to conform in full with the NMEA 0183 marine 
electronic device network communication standard, and 
are	flexible	enough	to	interface	to	most	fully	and	partially	
compliant devices.

2. Two ISO-Drive Outputs.
The ISO-Drive outputs comprise of two connections: ‘+/A’ 
and ‘-/B‘ and conform in full to the NMEA 0183 standard. 

3. RS232 Compatible Input/Output Option.
The	ISO	OUT	0	and	OPTO	IN	0	connections	can	be	used	
as	a	bidirectional	RS232	compatible	port	and	is	designed	
for direct connection to a Personal Computer (PC) or other 
marine	device	capable	of	interfacing	to	a	standard	RS232	
port. 

When	a	USB	cable	is	powered	and	plugged	into	the	NDC-
4, this port switches to output only - i.e. the RS232 input 
(OPTO IN 0) no longer operates.

4. A USB Input/Output (USB Variants Only).
The USB connector is designed for direct connection to a 
PC’s	 USB	 port.	 Once	 the	 USB	 cable	 is	 powered	 and	
plugged into the NDC-4, Port 0 switches to an output only 
mode	-	this	allows	the	USB	port	to	take	over	bidirectional	
control of the NDC-4.

5. Battery Supply Input.
Standard	battery	power	connections	(8	to	35v).

Notes:
1. To complete the NMEA 0183 standard all device 
interconnection	NMEA	cables	used	should	meet	the	two-
conductor,	 shielded,	 twisted	 pair	 configuration	
specification.	The	shield	connection	of	these	wires	should	
be	connected	at	the	instrument	end	only	to	prevent	ground	
loops.
2. Refer to “Specifications” on page 40 for the full details 
on	input/output	specifications.

The	NMEA	Data	Multiplexer	(NDC)	has	screw-terminal	“Phoenix”	type	external	connections	for:	-

Connections

Figure 1 – All external connections
N

M
EA

 D
A

TA
 C

O
M

BIN
ER 

99999 
N

D
C

-4-A
-U

SB
 



 

Page 10© 2015 Active Research Limited

OPTO Inputs
The differential opto-isolated inputs are designed to handle 
a	 variety	 of	 NMEA	 0183	 device	 output	 specifications.	
Please determine (from device manufacturer’s information) 
if	 the	 device(s)	 required	 to	 be	 connected	 to	 the	 NDC-4	
conforms in full to the NMEA 0183 network communication 
standard.	 If	 it	does	not,	 the	flexible	NDC-4	 inputs	should	
still	be	capable	of	interfacing	with	the	device,	though	this	is	
not guaranteed.  

The	diagram	above	shows	a	typical	installation	with	both	
fully compliant NMEA devices with differential inputs/
outputs, and non-differential output devices.

Note: All NDC-4 inputs are identical and the connections 
shown	are	examples	that	can	be	used	on	every	input	port.

NMEA Talker Devices 1 and 2: These devices conform in 
full to the NMEA 0183 standard. Talker 1 shares the same 
connection ID’s as the NDC-4, so connection is a simple 
matter of matching the ID’s. Connect ‘+’ to ‘+/A’ and ‘-’ to 
‘-/B’ or ‘A‘ to ‘+/A‘ and ‘B’ to ‘-/B’ (refer to figure 2).

NMEA Talker Devices 3 and 4: These devices do not 
conform completely to the NMEA 0183 standard. However, 
by	connecting	‘+‘ to ‘+/A‘ or ‘Data/Signal’ to ‘+/A‘ and ‘G/
Ground’ to ‘-/B’ the NDC-4 should receive the NMEA data 
correctly.

ISO-Drive Outputs
The	 ISO-Drive	 outputs	 are	 capable	 of	 driving	 up	 to	 10	
NMEA 0183 fully compliant listening devices, or a mixture 
of NMEA 0183 devices and a Personal Computer (PC) 
communication port. However, if you wish to maintain 
isolation	 between	 all	 devices,	 then	 only	 one listening 
device	should	be	connected	to	an	ISO-Drive	output.

NMEA Listener Device’s B and C: These devices 
conform in full to the NMEA 0183 standard and their 
connection ID’s match that of the NDC-4.

Personal Computer: Whilst the OPTO IN 0 and ISO-
Drive	0	provide	a	bidirectional	RS232	compatible	port		for	
connection	to	a	PC,	the	ISO-Drive	1	output	is	also	capable	
of	being	read	by	a	PC’s	RS232	port.	Simply	connect	‘+/A’ 
to ‘Rx’ and ’-/B’ to ‘G/Ground’ on a standard D-type 
connector. See “Figure 26 - DB9 Connection” on page 37 
for a diagram of this wiring connection.

NMEA Listener Device A: This device does not conform 
in	full	to	the	NMEA	0183	standard.	However,	by	connecting	
‘+/A‘ to ‘+‘ or ‘Data/Signal’ and ‘-/B’ to ‘G/Ground’ the 
device	should	be	able	to	receive	the	NMEA	data	correctly,	
though this is not guaranteed.

Note: Wire colours are for guidance only. 

Connecting to NMEA Devices

Figure 2 – NMEA 0183 connections
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Other Connections

Figure 3 – RS232, USB and Battery connections
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Connecting to the Battery Supply
The	NDC-4	can	be	powered	either	by	the	USB	connection	
or	through	an	external	power	source.	If	both	power	sources	
are	available,	the	precautions	in	the	USB	warning	section	
above	must	be	adhered	to.

If the NDC-4 is powered from an external power source, 
like	 a	 battery,	 it	 should	 be	 wired	 to	 the	 vessel’s	 battery	
supply	 in	 the	 most	 direct	 manner	 possible,	 to	 minimize	
interference	from	other	electronic	devices.	The	cable	used	
should	 be	 of	 sufficient	 gauge	 to	 handle	 the	 power	
requirements of the NDC-4 (refer to ”Specifications” on 
page 40).

Connecting to a Personal Computer
The	USB	port	can	be	used	to	connect	a	PC	to	the	NMEA	
0183	system.	A	USB	cable	 is	available	 in	 the	form	of	an	
upgrade	kit	for	variants	that	do	not	come	with	a	cable.	The	
part	number	will	include	“USB”	if	a	cable	is	provided	with	
that variant (e.g. NDC-4-USB).

Alternatively,	Port	0	(OPTO	IN	0	and	ISO	OUT	0)	can	be	
used	to	connect	a	PC	into	the	NMEA	0183	system	by	
using	 a	 serial	 port	 cable	 conforming	 to	 the	 following	
specification:

1. A D-type female (socket) connector for the PC end of 
the	cable.

2.	A	minimum	of	3	cores	are	required	in	a	shielded	cable.	
Higher	quality	cable	will	yield	higher	performance	(SNR).	
Most	 typical	cables	have	two	twisted	pairs	 inside.	 In	 this	
case, use one pair for the TX line and one for the RX line. 
Use the spare wire in each pair as ground, and connect 
the	cable	shield	to	ground	only	at	the	computer	end.

3. The TX	of	the	NDC-4	should	be	connected	to	the	RX of 
the computer (standard D-type, pin 2) and the NDC-4 RX 
should	be	connected	 to	 the	TX of the computer (pin 3). 
The GND	of	both	IN	0	and	OUT	0	on	the	NDC-4	should	be	
connected to the PC’s serial port ground (pin 5). See 
“Figure 26 - DB9 Connection” on page 37 for a diagram 
of this wiring connection.

Note: Wire colours are for guidance only. 

 

USB Warning!
USB	 power	 and	 battery	 power	 are	 NOT	

isolated	from	each	other.	Consult	a	qualified	installer	to	
ensure	there	is	no	ground	loop	hazard	when	connecting	
both.	Disconnecting	a	single	battery	lead	or	turning	off	
the	supply	does	NOT	prevent	this	ground	loop	hazard.	
Ground	loop	damage	is	NOT	covered	by	the	guarantee.

For installs where the NDC-4 must still operate when 
the	 PC	 is	 switched	 off,	 full	 PC	 isolation	 can	 be	
maintained	by	using	Port	0	(‘OPTO	IN	0’	and	‘ISO	OUT	
0’) as the PC connection.

Only	when	using	a	laptop	running	on	its	internal	battery	
(with	NO	charging	supply),	can	the	NDC-4	USB	cable	
be	used	at	the	same	time	as	powering	the	NDC-4	from	
the	ships	battery	on	the	“BATT”	terminals.

!
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USB Driver Installation
When	using	an	NDC-4	with	a	USB	cable	it	is	necessary	to	
install the USB drivers. Any NDC-4 variant without a USB 
cable	can	be	 ‘upgraded’	by	purchasing	a	USB Upgrade 
Kit from your dealer.

The	USB	cable	is	not	vital	to	the	configuring	or	updating	of	
an NDC-4; Port 0 (OPTO IN 0 and ISO OUT 0) connected 
to an RS232 port can perform exactly the same operations 
if	a	USB	cable	is	not	available	see	“Other Connections” 
on page 11.

The Actisense	 USB	 driver	 has	 been	 extensively	 tested	
with Windows versions from Windows 98SE to Windows 7 
and is proven to work with the NDC-4. The driver comes in 
two	parts	and	both	are	required	for	correct	operation.	The	
first	is	the	‘USB serial converter’ driver and the second is 
the ‘Virtual serial port’ driver.

The required Linux drivers are already included in the 
Linux kernels from v2.4.20 and onwards. However, 
Actisense	has	not	been	able	 to	 test	 the	compatibility	of	
the NDC-4 with USB and this driver. Install instructions are 
available	 on	 the	CD	and	 the	Actisense website (www.
actisense.com).

Drivers for MAC OS X are provided ‘as is’ and Actisense 
is	 unable	 to	 offer	 support	 for	 MAC	 related	 issues.	 To	
download the drivers visit the Actisense website (www.
actisense.com).

Installation Guide
Windows 7 and Windows Vista
The following instructions are for Windows 7. Although not 
the	 same,	Windows	Vista	 users	will	 be	 able	 to	 use	 this	
information to install the drivers as well.
With an active Internet connection the process is very 
simple.	 Connect	 the	 USB	 cable	 and	 Windows	 will	
automatically download and install the latest driver from 
Windows update. Both drivers are now installed and no 
further steps are required.

When there is no Internet connection Windows will fail to 
install the driver.

Follow these steps to manually install the drivers from the 
Actisense CD or a copy downloaded from the Actisense 
website.

1. Open ‘Device Manager’ (from the start menu type 
‘device manager’	in	the	search	box,	open	it	from	the	list).	

2. Find the NDC-4 under ‘Other devices’ and right click, 
then select ‘Update Driver Software’.

3. If the CD is inserted select ‘Search automatically for 
updated driver software’	and	jump	to	step	4.
Without the CD select ‘Browse my computer for driver 
software’.

www.actisense.com
www.actisense.com
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4. Click the ‘Browse’	button	and	locate	the	folder	that	the	
USB	driver	 is	 saved	 (containing	 “ftdibus.inf”). Once 
the folder is selected click ‘Next’.

5. When the ‘USB Serial Converter’ driver has completed 
the ‘Virtual Serial Port’	driver	will	need	to	be	installed	in	
the same way. This time in ‘Device Manager’ right click 
‘USB Serial Port’ and select ‘Update Driver Software’.

6. Repeat steps 3 and 4 to install the ‘Virtual Serial Port’ 
driver.

Now	both	drivers	are	installed	see	“USB Configuration” 
on page 14	for	details	on	how	to	find	out	which	COM	port	
number	has	been	allocated	to	your	Actisense device as 
well as how to change to a different COM port.

Windows XP and Windows NT/2000
The following instructions are for Windows XP. Although 
not	the	same,	Windows	NT/2000	users	will	be	able	to	use	
this information as well.

1.	Connect	the	USB	cable	and	Windows	will	automatically	
open the ‘Found New Hardware Wizard’. If an active 
Internet	 connection	 is	 available	 select	 ‘Yes, this time 
only’, click ‘Next’ and go to step 4. Without an active 
Internet connection select ‘No, not at this time’ and click 
‘next’.

2. If using drivers from the CD, choose ‘Install the 
software automatically (Recommended)’ and click 
‘next’. Windows will search the CD and install the drivers, 
go to step 4. If using drivers downloaded from the 
Actisense	website,	choose	‘Install from a list or specific 
location (Advanced)’ and click ‘Next’. 
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3. When using the drivers downloaded from the Actisense 
website,	 it	 is	 important	 to	 unzip	 them	 to	an	easy	 to	 find	
location. Make sure the ‘Include this location in the 
search’ option is ticked, and use the ‘Browse’	button	and	

select	 the	 folder	where	 the	 drivers	 have	 been	 extracted	
and click ‘Next’.

4. The ‘USB serial converter’ driver is now installed, click 
‘Finish’	to	complete	the	wizard.
5.  Once complete ‘Your new hardware is installed and 
ready to use’	will	appear	in	the	bottom	right	corner	of	your	
screen.

Wait for the ‘Found New Hardware Wizard’ to appear 
again. Repeat steps 1 to 4 to install the ‘Virtual Serial 
Port’ driver.

Now	both	drivers	are	installed	see	“USB Configuration” 
on page 14	for	details	on	how	to	find	out	which	COM	port	
number	has	been	allocated	to	your	Actisense device as 
well as how to change to a different COM port.

USB Configuration
To	communicate	with	 the	NDC-4,	 the	COM	port	number	
that	Windows	has	allocated	to	the	USB	port	needs	to	be	
determined. The following guide will walk the user through 
this standard operation.

The Actisense NMEA Data Multiplexer, NDC-4 is 
completely	 USB	 port	 independent:	 It	 can	 be	 easily	
unplugged from one USB port and connected to another 
available	USB	port	on	the	same	PC	without	the	COM	Port	
number	changing.

This is very useful when the NDC-4 is working in unison 
with a software program that is set up to use a particular 
COM port, as the user does not need to re-select a different 
COM	 port	 every	 time	 the	 PC	 reboots,	 or	 the	 cable	 is	
swapped	between	two	USB	ports.

Locate and Change the Port Number
1.	Connect	 the	NDC-4	USB	cable	 to	a	USB	port	on	 the	
PC.

In Windows 7 and Vista; from the start menu type ‘Device 
Manager’	in	the	search	box,	open	it	from	the	list.	

In Windows XP; from ‘Control Panel’, select ‘System’, on 
the ‘Hardware’	tab	click	‘Device Manager’.
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2.	Expand	the	‘Ports	(COM	&	LPT)’	list	by	clicking	on	the	
‘+’ sign (Windows XP and Vista) or the white arrow 
(Windows	7).	You	will	find	the	‘Actisense NDC’ in the list, 
followed	by	the	allocated	COM	port	number.

3.	Double	click	on	the	icon	for	the	 ‘Actisense NDC’ and 
the properties window will appear. Click on the ‘Port 
Settings’ tab.	 There	 is	 no	 need	 to	 change	 any	 of	 the	
settings here, the software package that opens the port 
will specify the required values.

4. Click on the ‘Advanced’	button	and	choose	a	different	
COM	Port	number	if	required	(to	make	it	compatible	with	
the software requiring the NDC-4 NMEA data).

Figure 4 - COM Port Numbers List

Windows	remembers	all	previously	connected	USB	ports	
and lists all these as ‘in use’ even when they are not 
connected. On the PC the screen-shot “Figure 4 - COM 
Port Numbers List” the only ports that are actually ‘in 
use’	are	ports	1,	2	and	3	so	all	the	other	com	port	numbers	
are	 available.	 Click	 on	 ‘OK’	 button	 to	 save	 the	 new	
settings.
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Actisense PC Software suites
The Actisense	NMEA	Data	Combiner	 hardware	 can	 be	 configured,	monitored	 and	 tested	 using	 its	 own	dedicated	
software	suite,	‘NDC	Control	Centre’.	The	NDC-4	can	be	updated	/	upgraded	using	the	latest	ActiPatch	software	suite.	
This section provides a complete users guide to installing and uninstalling these two software suites.

These	programs	are	currently	only	available	for	Windows	NT/2000/XP/Vista/7,	however,	it	has	been	proven	possible	to	
use Control Centre and ActiPatch on a Mac running ‘VMware Fusion’ Windows emulation software.

Installing Actisense PC software
Replace the generic “<Product Name>”	text	below	with	
the name of the actual software you are installing: “NDC 
Control Centre”, or “ActiPatch”.

1. Download the latest version of the software from the 
Actisense website,	or	 locate	the	files	on	the	Actisense 
CD included with the NDC-4.

2.	If	a	previous	version	of	the	software	has	already	been	
installed, uninstall the previous version before installing 
the new version.  Refer to “Uninstalling Actisense PC 
software” on page 17 for full details.

Note: For a complete fresh install, delete the install 
directory. This will remove all previous settings. To keep 
these settings, do not delete the directory.

3.	If	the	program	is	contained	within	a	zip	file,	extract	the	
three	 files	 (“<Product Name>.001”, “<Product 
Name>.002” and “setup.exe”) that are contained within 
the	 zip	 file	 using	 any	 available	 unzip	 program	 to	 a	
temporary directory (e.g. “C:\Temp”).

4.	 Double	 click	 on	 the	 “setup.exe”	 program	 file	 and	
follow the on-screen instructions of the 
standard Windows install program. The 
install	location	can	be	change	at	this	point,	
however, the default location is normally 
acceptable	 (refer	 to	 “Figure 5 – Install 
Options” and “Figure 6 – Installation 
Complete”).
 
Once the install operation is complete, the 
temporary	 files	 and/or	 directory	 can	 be	
deleted.	Keep	the	original	zip	file	safe.

5. From the ‘Start Menu’ navigate to the 
‘Actisense’	directory	and	double	click	on	
the ‘Program’ icon (refer to “Figure 7 - 
‘Start Menu’ Short-cuts” and “Figure 8 
– ‘Start Menu’ Short-cuts”).

Useful Tip: If you access the program 
regularly you can ‘copy and paste’ the 
program icon from the Windows ‘Start Menu’ on to the 
desktop or the ‘Quick Launch’	short-cut	bar	to	create	an	
easy to access short-cut.

Figure 5 – Install Options

Figure 6 – Installation Complete

Figure 7 - ‘Start Menu’ Short-cuts

Figure 8 – ‘Start Menu’ Short-cuts

http://www.actisense.com
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Uninstalling Actisense PC software
Replace the generic “<Product Name>”	text	below	with	
the name of the actual software you are installing: “NDC 
Control Centre”, or “ActiPatch”.

1. To uninstall the program, from the ‘Start Menu’ navigate 
to the ‘Actisense’	 directory	 and	 double	 click	 on	 the	
‘Uninstall’ icon (refer to “Figure 7 - ‘Start Menu’ Short-
cuts” on page 16 and “Figure 8 – ‘Start Menu’ Short-
cuts” on page 16).

3.	Once	 the	uninstall	operation	has	been	 requested,	 the	
confirmation	box	(“Figure 9 – Uninstall Confirmation”) 
will	be	displayed.	Answer	‘Yes’	and	the	uninstall	operation	
will	 be	 performed	 automatically.	 After	 successfully	
uninstalling the Actisense PC software, the uninstall 
completion	 box	 will	 appear	 (“Figure 10 – Uninstall 
Complete”).

4.	In	addition,	the	program	directory	can	also	be	deleted	to	
completely remove the program. In this way all the program 
files	will	be	uninstalled	in	a	clean	and	complete	manner.

If however, you are going to install a new version after this 
uninstall, you can keep the program directory and the 
configuration	file	stored	within	 it.	 In	 this	way,	all	 the	user	
settings	 you	 had	 for	 the	 previous	 version	 will	 be	
immediately	available	with	the	new	version.

Figure 9 – Uninstall Confirmation

Figure 10 – Uninstall Complete
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Using NDC Control Centre
The Actisense	NMEA	Data	Combiner	hardware	can	be	configured	and	monitored	using	 its	own	dedicated	Control	
Centre suite. This section provides a complete users guide to all of the NDC Control Centre’s features.

This	program	is	currently	only	available	for	Windows	NT/2000/XP/Vista/7,	however,	it	has	been	proven	possible	to	use	
Control Centre on a Mac running ‘VMware Fusion’ Windows emulation software.

Main window

Figure 11 – Control Centre Main Window (after hardware detected)

Control Centre’s main window allows the user access to 
all	 the	 NDC-4	 hardware	 configuration	 and	 monitoring	
features,	and	adjustment	of	Control	Centre’s	appearance	
on screen.

Control	 Centre	 is	 capable	 of	 displaying	 a	 large	 array	 of	
data	and	information,	and	not	all	will	be	of	interest	to	every	
user. Therefore, the user can easily select which 
information	/	status	windows	are	visible,	and	which	are	not	
(hidden).

To	 meet	 the	 users	 specific	 requirements,	 any	 visible	
window	can	be	repositioned	on	the	screen	by	dragging	it	
with the mouse. If a window is dropped (the left mouse 
button	is	released	after	the	drag	operation)	close	enough	
to	an	adjacent	windows	edge,	it	will	snap	to	that	windows	
edge. This allows for quick, easy and neat arrangement of 
Control Centre’s windows.

From the main window the user can select what Baud 
rates the various inputs and outputs of the NDC-4 need to 
be,	and	even	change	the	input	port	priorities.	Selection	of	
these	options	are	possible	by	using	the	standard	Windows	
menu system (‘Options’	 menu)	 or	 via	 a	 tab	 system	
(behaving	just	like	tabs	in	a	filing	cabinet).	Full	explanation	
of these features is detailed in the following sections.

Any changes the user makes to Control Centre’s 
appearance	will	be	remembered	for	subsequent	sessions,	
allowing the user to keep their favourite settings. Any new 
configuration	settings	must	be	downloaded	to	the	NDC-4’s	
hardware	 before	 they	 can	 be	 remembered	 -	 this	 helps	
keep Control Centre and NDC-4 hardware in sync.

The main window has an ‘Exit’	control	button	to	close	the	
Control Centre program. If any changes to the Port 
Configurations	have	been	made,	but	not	yet	transferred	to	
the	NDC-4	hardware,	the	user	will	be	asked	to	confirm	the	
exit	request	(as	all	alterations	will	otherwise	be	lost	when	
the program closes).
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Connecting to Control Centre
Important information - please read.

Figure 12 – Control Centre Main Window (before hardware detected)

Control Centre’s appearance and all other settings are 
stored	 in	 the	 file	 “ControlCentre.ini” which is 
automatically loaded at start-up and saved on exit.

Note: Do not attempt to edit the “ControlCentre.ini” 
file	by	hand,	this	can	stop	the	program	running.

To	access	all	the	Control	Centre	configuration	features,
Control	 Centre	 must	 first	 detect	 what	 type	 of	 NDC	 is	
connected.	 This	 allows	 the	 same	 Control	 Centre	 to	 be	
used for the NDC-1, NDC-2, NDC-3 and NDC-4 (as  they 
all	have	different	configuration	and	test	options).

Before	the	NDC-4	hardware	is	detected	by	Control	Centre,	
the main window will look like that in “Figure 12 – Control 
Centre Main Window (before hardware detected)” with 
the sections ghosted out. 

Once	detected,	any	disabled	options	that	are	available	for	
the	detected	NDC-4	type	will	become	active	and	the	main	
window will look like that in “Figure 11 – Control Centre 
Main Window (after hardware detected)” on page 18.

Initial connection procedure
1a. USB Connections Only:
If using an Actisense USB kit: Connect the provided USB 
cable	 to	 an	 available	 USB	 port.	 Refer	 to	 “Other 
Connections” on page 11 for more details.

1b. RS232 Connection Only:
If	 using	 an	 NDC-4	 without	 the	 USB	 kit:	 connect	 battery	
power	(10	-	35v)	and	switch	on	the	battery.	Connect	port	0	
(ISO OUT 0 and OPTO IN 0) to the PC. Refer to 
‘Connecting	 to	 the	 battery	 supply’	 and	 ‘Connecting	 to	 a	
Personal Computer’ on “Other Connections” on page 11.

2. The NDC’s LED will cycle through its standard start-up 
colours	(‘red’,	‘amber’	and	finally	‘green’).

3.	Select	the	PC	Comm	port	number	that	the	RS232	cable	
was	 plugged	 into	 (or	 the	 USB	 port	 that	 was	 issued	 by	
Windows) from the ‘Comms’ drop menu in the main 
window. See “Locate and Change the Port Number” on 
page 14. The Baud rate will default to 38400 Baud (the 
factory	default),	but	will	auto-Baud	to	the	actual	Baud	rate	
if	it	has	been	changed.

4. The Rx and Tx	LED’s	on	the	main	window	will	flash	to	
indicate	 that	 communication	 is	 in	 progress	 (between	
Control Centre and the NDC-4 hardware). Once the 
hardware	information	has	been	received	(and	displayed),	
all	 the	 NDC-4	 configuration	 and	 test	 options	 will	 be	
enabled.	If	for	any	reason	the	hardware	detection	operation	
does	not	happen	as	described,	refer	to	the	“Diagnosing 
The NDC Control Centre Connection” on page 37.

The	 default	 configuration	 for	 the	 NDC-4	 is	 explained	 in	
“Default Port Configuration Set-up” on page 21.
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Pull-down Menus
The	main	window	has	five	standard	pull-down	menus.

File → Load / Save Configuration File:
Load	 and	 save	 configurations	 that	 include	 all	 ‘Port 
Configure’  and ‘Inclusion List’ settings. Both options 
open	a	standard	windows	file	browser	dialogue	window.

Note: Do not confuse these “Config.ini”	files	with	 the	
“ControlCentre.ini”	 file,	 see	“Initial hardware and 
software set-up” on page 19.

File → Exit:
Closes the Control Centre program. If any changes to the 
Port	 Configurations	 have	 been	 made,	 but	 not	 yet	
transferred	to	the	NDC-4	hardware,	the	user	will	be	asked	
to	confirm	the	exit	request	(as	all	alterations	will	otherwise	
be	lost	when	the	program	closes).

Options → Configure Ports:
This	will	take	you	to	the	Port	Configuration	tab	refer	to	the		
“Port Configuration tab” on page 21.

Options → Configure Inclusion Lists:
This	 will	 take	 you	 to	 the	 Inclusion	 List	 configuration	 tab	
refer to the “Inclusion List configuration tab” on page 24.

Options → Test Hardware:
The	Test	hardware	tab	is	not	required	/	selectable	for	the	
NDC-4 (only required for the NDC-2 Multiplexer).

Comms → Offline: 
The	offline	option	closes	the	communication	port.

Comms → Comm Port 1-8:
Opens the PC communications port in the range of port 1 
to 8. Select the port the NDC-4 hardware is attached to.

Comms → Comm Port x (change):
For ports outside the 1-8 range, select this option. A 
dialogue	will	open	to	enter	the	port	number	required.	Once	
opened the ‘x’	 will	 be	 replaced	 with	 the	 selected	 port	
number	in	the	drop	down	list.

Comms → Baud Rate *****:
The Baud rate will default to 38400 (the NDC-4 hardware 
default). If the NDC-4 is not using the default Baud rate, 
Control	 Centre	 will	 try	 all	 possible	 Baud	 rates	 until	 the	
correct one is found (this will take up to 12 seconds). 
Selecting	a	baud	rate	from	this	list	will	try	the	rate	before	
returning	to	auto	baud	checking.

Window → Control Centre Port Status:
Displays the Control Centre Port Status window. Refer to 
“Control Centre Port Status Window” on page 27.

Window → NDC Hardware Port Status:
Displays the NDC Hardware Port Status window. Refer to 
the “Hardware Port Status Window” on page 28.

Window → NDC Hardware Connect Status:
Displays the NDC Hardware Connection Status window. 
Refer to the “Hardware Connection Status Window” on 
page 28.

Window → NDC Hardware Information:
Displays the NDC Hardware Information window. Refer to 
the “Hardware Information Window” on page 29.

Help → Control Centre Help:
Currently	unavailable	(not	selectable).

Help → About Control Centre:
Displays	 Control	 Centre’s	 software	 version	 number	 and	
the Actisense contact information.
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Port Configuration Tab
The	Port	configuration	tab	of	the	main	window	allows	the	user	to	select	the	priority	and	Baud	rates	of	the	NMEA	and	
USB / RS232 input ports of the NDC-4 hardware, plus other useful features.

Figure 13 – Port Configuration Tab

Port Configuration Tab Features
The	Port	Configuration	tab	consists	of	drop	down	menus	
for	baud	rates,	 the	port	priority	 list	and	action	and	mode	
buttons	“Figure 13 – Port Configuration Tab”.

Default Port Configuration Set-up
This section explains the default settings of the NDC-4, to 
return to this point refer to “Reset Port Configuration to 
defaults” on page 23.

1. The USB / RS232 communication port defaults to 38400 
Baud for use with a personal computer. This is more than 
capable	of	transferring	the	received	data	of	all	four	NMEA	
input ports. However, if connecting the NDC-4 to an RS232 
compatible	device	 that	 does	not	 support	 38400	Baud	or	
there are multiple Hi-Speed NMEA inputs, then the rate 
can	 be	 changed.	 Refer	 to	 “Changing Baud Rates for 
Each Port” on page 22.

2. ‘Extra ARL P-codes’ are disabled, typically only 
needed for specialist software such as Control Centre. 
See “Extra ARL P-codes” on page 22 for more details.

3. ‘Clone output mode’ is disabled,	filtering	is	applied	to	
OUT 1 and NOT to USB/OUT 0. See “Clone Mode” on 
page 23 for more details.

4. The NMEA 0183 standard determines the Baud rate of 
4800. The OPTO IN 1-4 ports default to 4800 Baud to 
match this standard. If a special devices that offers a 
different	Baud	rate	needs	to	be	connected,	then	the	rate	
can	 be	 changed.	 Refer	 to	 “Changing Baud Rates for 
Each Port” on page 22.

5. ‘Delete Duplicates’ is enabled, during overload 
conditions duplicates are deleted, refer to “Delete 
duplicates” on page 23 for more details.

6. The topmost port in the list has the highest priority and 
the	port	at	the	bottom,	the	lowest.

Note:	The	USB	/	RS232	output	is	unaffected	by	the	NMEA	
Port Priorities, and typically retains all received data.

7.	All	NDC-4	variants	default	to	Combiner	mode	except	for	
the NDC-4-ASW which defaults to Autoswitch mode. Refer 
to  for more details.
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Changing Baud Rates for Each Port

RS232 or IN/OUT 0 or USB click the arrow to reveal the 
available	Baud	 rate	 options;	 4800,	 9600,	 19200,	 38400,	
57600 or 115200 Baud. Select the required Baud rate from 
the list. Please read the “Low Baud Rate Warning” 
adjacent.

‘NMEA	Ports’	1	to	4	all	have	drop	down	menus	that	can	be	
accessed	by	clicking	the	arrow	next	to	the	relevant	 input	
port.	 Select	 the	 required	 baud	 rate	 from	 the	 available	
options	as	explained	below.

OPTO	 input	 1	 and	 the	Combined	NMEA	output	 are	 two	
sides of the same port, and therefore share the same 
Baud	rate	(with	options	between	4800	and	57600	Baud).

OPTO inputs 2 and 3 also have the same Baud rate 
options	of	4800	to	57600	Baud.		Inputs	1,	2	and	3	can	be	
used as hi-speed inputs (ideal for AIS transponders).

OPTO	input	4	is	fixed	to	the	standard	4800	Baud	rate.

Notes:
1.	The	NDC-4	 receives	and	buffers	all	 the	NMEA	 	0183	
sentences from all 5 inputs (4 NMEA 0183, and 1 USB / 
RS232), and then as a totally independent operation, it re-
sends the required NMEA 0183 sentences out of the 2 
ISO-Drive outputs.
2.	The	NMEA	0183	specification	restricts	the	Baud	rate	for	
NMEA data to 4800 Baud. Therefore, any input port that 
has an NMEA device attached to it that cannot modify its 
Baud rate must remain at 4800 Baud (otherwise no data 
will	 be	 received).	 However,	 some	 NMEA	 devices	 (e.g.	
GPS	units)	allow	for	the	Baud	rate	to	be	increased	to	9600	
Baud, or even 38400 Baud (Hi-Speed NMEA). Only in 

these cases should the Baud rate of the appropriate port 
be	changed	from	4800	Baud	to	match	that	of	the	attached	
device.
3.	It	is	perfectly	acceptable	to	have	each	ports	Baud	rate	
set to different values. This means, for example, that input 
2	can	be	different	to	output	1.	Sentences	arriving	at	input	2	
will still leave from output 1 irrelevant of the different Baud 
rates.	Care	should	be	taken	to	ensure	data	is	not	lost	due	
to overloading when selecting differing Baud rates.

Low Baud Rate Warning
Setting	 the	 USB/RS232	 Baud	 rate	 below	 38400	 Baud		
may	reduce	the	bandwidth	of	this	output	below	that	of	the	
total	 input	 bandwidth.	 This	 may	 result	 in	 the	 following	
issues:
1. It is highly likely that Control Centre will lose connection 
to	 the	 NDC-4.	 If	 this	 happens,	 remove	 or	 disable	 ALL 
inputs  to the NDC-4 leaving only the PC connection. Now 
Control Centre can catch the NDC-4 and you can change 
the	USB/RS232	Baud	back	to	a	high	enough	Baud	rate.
2. Random loss of NMEA sentences can occur during 
normal operation (when not connected to Control Centre). 
To ensure no data is lost 38400 Baud is recommended. 
For exceptional requirements were the total input 
bandwidth	is	low	enough,	any	of	the	available	Baud	rates	
can	be	used.

Changing the Addition Features

Extra ARL P-codes
When Enabled, extra ARL P-code sentences appear on 
the	USB	/	OUT	0	port.	These	P-codes	are	used	by	Control	
Centre to determine which NDC-4 input supplied which 
piece of NMEA data. Control Centre can now show what 
data	came	from	channel	1,	channel	2,	etc.	This	ability	 is	
also open to any other PC program. For example, an 
NDC-4 with 4 digital NMEA depth sounders connected to it 
could have the 4 individual depth values shown on a PC 
screen	 in	 representative	 positions	 (bow	 starboard,	 bow	
port,	stern	starboard	and	stern	port).
When Disabled, ARL P-code sentences do not appear on 
the USB / OUT 0 port. In the unlikely event the USB / OUT 
0 port is connected to a device that cannot ignore the 
P-codes,	 then	 these	 P-codes	 can	 be	 disabled	 to	 aid	
compatibility.
Default setting: Disabled.	Click	the	button	to	toggle.

Notes:
1. Control Centre requires the extra ARL P-code sentences 
to operate correctly. Control Centre turns on these codes 
while	connected	to	the	NDC-4,	ignoring	the	user	configured	
settings. When Control Centre is closed, the NDC-4 will 
revert	back	to	the	user	configured	settings.
2.	P-codes	arriving	on	the	input	ports	are	not	affected	by	
this	feature,	only	those	generated	by	the	NDC-4.
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Clone Mode
When Enabled,	the	USB	/	OUT	0	output	will	be	a	clone,	or	
copy,	of	the	NMEA	Combined	output	(OUT	1).	This	means	
that		filtering	will	be	applied	to	BOTH	outputs.	
When Disabled, the USB/OUT 0 output will contain all 
data	received	on	all	4	of	the	NMEA	inputs	(filtering	applied	
only to OUT 1).
Default setting: Disabled.	Click	the	button	to	toggle.

Delete duplicates
When Enabled, any duplicate NMEA sentences found in 
the	 receive	 buffer	 (that	 are	 deemed	 	 safe	 to	 delete)	 the	
older	version	(duplicate)	will	be	deleted.	This	 intelligently	
reduces the output data when too much data is coming 
through the input channels. For example, if two depth 
sentences	are	in	the	buffer	ready	to	be	transmitted,	there	
is normally no point in transmitting the older depth value, 
as the newer one has replaced all previous ones.
When Disabled,	 duplicates	 will	 not	 be	 deleted	 when	
overloaded, see “How Does the Port Priorities System 
Work?” on page 23.
Default setting: Enabled.	Click	the	button	to	toggle.

Note: Duplicates are only deleted during overloading 
conditions,	 these	 can	 be	 seen	 in	 the	 “Hardware Port 
Status Window” on page 28.

Port Priorities List
The topmost port in the list has the highest priority and the 
port	at	the	bottom,	the	lowest.	To	make	it	easy	to	remember,	
the default Input Port Priority is in port order starting with 
NMEA Port 1 (highest priority) to NMEA Port 4 (lowest  
priority).	The	USB/IN	0	port	 connection	has	been	added	
onto the end of the list. If for some reason the port priorities 
require changing and it is inconvenient to alter the 
hardware	connections,	the	port	priorities	can	be	changed.	

Note: The priorities system ONLY applies to OUT 1 and 
has NO EFFECT on the USB / OUT 0 port.

Changing the Port Priorities
Click on two ports in the Input Port Priorities List and their 
positions will swap in the list.

Why is There a Need for Port Priorities?
Each	of	the	five	NMEA	input	ports	can	transfer	anything	up	
to	480	bytes	of	data	per	second,	making	a	 total	of	1920	
bytes/second.	The	data	combined	output	of	the	NDC-4	is	
also	 forced	 (by	 the	 NMEA	 0183	 standard)	 to	 send	 a	
maximum	of	480	bytes/second.	Therefore,	there	exists	the	
distinct	possibility	 that	 there	could	be	more	data	 to	send	
out	than	is	possible	to	achieve.	If	this	situation	occurs	the	
port priority system comes into operation.

How Does the Port Priorities System Work?
The system uses time slots, each slot allows one NMEA 
0183	sentence	to	be	sent	until	either	no	data	remains	or	
the transmit capacity has reached its maximum. The 
highest	priority	input	port	has	the	highest	number	of	time	
slots the next highest priority port has less time slots, down 
to the lowest priority input port that has only a few time 
slots. 

Notes:
1.	The	NDC-4	stores	sentences	 in	a	buffer	so	 that	short	
periods	 of	 high	 load	 just	 causes	 a	 delay	 rather	 than	
dropped	sentences.	When	 the	buffer	becomes	 full	 some	
sentences	will	have	to	be	dropped.	If	the	rate	drops	below	
the	buffer	maximum	again,	all	sentences	will	be	sent	at	the	
next opportunity.
2. The time-slot method means that sentences from the 
highest	priority	channel	can	still	be	dropped	when	heavily	
overloaded and some sentences from the lowest priority 
channel will still get through.

Changing Autoswitch/
Combiner Mode
The	NDC-4	has	the	ability	to	operate	as	
a	 multiplexer/combiner	 or	 as	 an	
autoswitch.	Simply	 click	 the	 button	 and	
follow the prompt to change mode. Refer 

to “Setting the NDC-4 as an Autoswitch” on page 31 for 
more information on Autoswitch mode.

Get from Hardware
Reads	 the	 current	 Port	 Configuration	
information from the connected NDC-4 
hardware.	This	will	overwrite	any	current	settings	held	by	
Control	Centre’s	Port	Configuration;	if	the	current	settings	
must	 be	 remembered,	 save	 the	 configuration	 “File → 
Load / Save Configuration File” on page 20	 before	
requesting this operation.

Reset to Defaults
Returns	 all	 Port	 Configurations	 to	 the	
factory defaults, see “Default Port 
Configuration Set-up” on page 21.

Send to Hardware
If	any	alterations	to	the	port	configuration	
settings have occurred, Control Centre 
will now attempt to download the new 
settings to the attached NDC-4 hardware. The “Flash 
Hardware Window” on page 26	will	appear	for	the	brief	
duration of the download (normally one to two seconds).

Note:	Pressing	any	of	the	threes	buttons	above	will	only	
affect	 the	 Port	 Configuration	 settings,	 all	 Inclusion	 List	
configuration	 settings	will	 remain	 unaffected	as	 they	are	
controlled	by	their	own	independent	set	of	buttons.
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Inclusion List Configuration Tab
The	 Inclusion	List	configuration	 tab	of	 the	main	window	allows	 the	user	 to	select	which	NMEA	sentences	are	 to	be	
included	in	the	onward	data	transmission	from	the	NMEA	Data	Combiner.	Each	of	the	four	NMEA	input	ports	and	the	
USB	input	port	have	their	own	Inclusion	List,	so	that	each	can	be	tuned	separately	to	match	its	connected	device.

Figure 14 – Inclusion List configuration tab

Why is there a need for Inclusion Lists?
Each of the 5 input ports can transfer anything up to 480 
bytes	of	data	per	second,	making	a	total	of	1920	bytes	per	
second.	The	data	combined	output	of	 the	NDC-4	 is	also	
forced	(by	the	NMEA	0183	standard)	to	send	a	maximum	
of	 480	 bytes	 per	 second.	 Therefore,	 there	 exists	 the	
distinct	possibility	 that	 there	could	be	more	data	 to	send	
out	 than	 is	 possible	 to	 achieve	 -	 thus,	 some	 data	 may	
require	 removal	 to	 balance	 this	 equation.	 The	 NDC-4	
achieves this reduction in an intelligent manner with 
Inclusion Lists and Port Priorities.

Is some NMEA data really unnecessary?
Many	 NMEA	 instruments	 output	 a	 large	 number	 of	
sentences every period (usually 1-3 seconds), some of 
this	data	is	of	absolutely	no	use	to	the	average	boat	owner,	
and	just	clogs	up	the	NMEA	network.	Most	GPS	units	are	
especially guilty of this and not all allow the user to reduce 
the	number	of	unwanted	sentences	 that	are	 transmitted.	
Of	 those	 that	 do,	 the	 procedure	 can	often	be	 tricky	 and	
time consuming.

The	NDC-4	can	filter	the	incoming	NMEA	data	to	remove	
any sentences deemed unnecessary.
For	example,	most	GPS	units	send	 their	data	 in	a	block	

once a second. This may automatically include the ‘GSV’ 
sentences	(normally	2	but	could	be	as	many	as	4),	which	
give details of all the satellites that are currently in view. All 
of	 this	 information	 is	of	no	use	 to	99%	of	users,	but	 this	
alone	can	use	up	to	5%	of	the	available	NMEA	bandwidth/
capacity.

Is filtering applied to the input or the output?
Sentences	to	be	included	are	selected	relative	to	the	input	
port they are coming from. By default this is applied to ISO 
OUT 1 and not ISO OUT 0, see “Clone Mode” on page 23.

Inclusion List Features
The	Inclusion	List	configuration	tab	consists	of	several	tick	
boxes	for	included	sentences,	a	channel	drop	down	menu	
and	 action	 buttons	 “Figure 14 – Inclusion List 
configuration tab”.

Default Inclusion List Set-up
The NDC-4 ‘Inclusion List’ default is to allow all sentences 
through. The inclusion list will show no ticks and a red 
label	stating	‘Pass all data’.
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Editing the Inclusion List 
Channel Selection List
Determines which input channel 
(port) has its Inclusion List displayed. 
Editing	 the	visible	controls	displayed		
here will only affect the selected port.

Main Tick-box Area (left)
Each NMEA 0183 sentence has its own individual tick-
box,	and	is	intended	for	the	advanced	user	to	fine	tune	the	
selection to exactly what is required (as this requires 
detailed knowledge of NMEA 0183 sentences). Select the 
individual sentences that are required to pass through the 
NDC-4 from this input.

Sentence Groups Tick-box Area (right)
To make selection of NMEA 0183 sentence’s easier, all 
sentences	 of	 a	 particular	 type	 have	 been	 collected	
together, and is primarily intended for the novice user who 
does not know which sentences contain what information. 

The NMEA sentence collections are designed for quick list 
configuration;	 each	 collection	 influences	 all	 the	 NMEA	
sentence	tick-boxes	in	the	main	(left)	area	that	contain	the	
selected information.

The	 tick-box	 operation	 is	 straightforward:	 If	 the	 box	 is	
ticked, the corresponding NMEA sentence will appear on 
the	combined	NMEA	output.	Conversely,	if	the	box	is	not	
ticked,	that	NMEA	sentence	will	be	blocked	and	not	appear	
on	the	combined	output.

Set/Clear All Sentences
To	completely	disable	the	Inclusion	
List for a particular channel, click 
on the Clear all sentences	button.	
The list status indicator will then 
change	 from	 the	 green	 List	Enabled	 to	 the	 red	Pass	 all	
data	 state	 and	 the	 Sentence	Total	 box	will	 update	 to	 0.	
Clicking	 the	Set	all	 sentences	button	will	 tick	every	box,	
change	 the	 red	Pass	 all	 data	 to	 the	 green	 List	 Enabled	
state	 and	 the	 Sentence	 Total	 box	 will	 update	 to	 101	
sentences.

Once	disabled	(and	Pass all data is displayed), all NMEA 
sentences	will	be	passed	to	the	NMEA	combined	output	-	
no	filtering	will	occur	on	this	channel.	This	is	useful	when	
trying	to	pass	an	NMEA	sentence	that	is	not	available	for	
selection in the Inclusion List.

The	buttons	Clear all sentences and Set all sentences 
are useful to quickly reset or set all tick marks. This allows 
for	quick	configuration	of	the	Inclusion	List	without	having	
to	click	on	every	tick	box.	For	example,	if	only	a	couple	of	
sentences	 are	 required	 to	 be	 set,	 press	 the	 Clear all 
sentences	 button	 followed	 by	 selecting	 the	 required	
sentence ID’s.

Sentence Total
The	total	number	of	NMEA	sentences	currently	
selected	/	enabled	for	the	current	channel	/	port	
is	 displayed	 in	 the	 bottom	 right	 corner.	This	 is	
purely for user information and interest.

Blocking ALL Sentences
There	is	no	option	to	block	all	sentences.	However,	there	
is a work-around. Simply tick a sentence that is never 
going	to	be	present	on	that	input.	For	example	to	block	all	
AIS sentences tick AAM (waypoint arrival alarm). This will 
enable	the	filtering	and	block	everything	except	AAM,	and	
because	 AAM	 is	 never	 transmitted	 by	 an	 AIS	 unit	 no	
sentences	will	 be	 passed	 from	 this	 input	 to	 ISO	OUT	 1	
(and	also	ISO	OUT	0	if	Clone	mode	is	enabled).

Get from Hardware
Reads/retrieves the current Inclusion 
List information, for all channels, from 
the connected NDC-4 hardware. This will overwrite any 
current	settings	held	by	Control	Centre’s	Inclusion	Lists;	if	
the	 current	 settings	 must	 be	 remembered,	 save	 the	
configuration	“File → Load / Save Configuration File:” 
on page 20	before	requesting	this	operation.

Reset to Defaults
Returns all channel Inclusion Lists to the 
factory default see “Default Inclusion 
List Set-up” on page 24.

Note: This only changes the Control Centre settings, click 
‘Send to Hardware’ to apply these settings to the NDC-4.

Send to Hardware
Finalises the Inclusion List editing 
operation. If any alterations to the list 
have occurred, Control Centre will now attempt to 
download the new settings to the attached NDC-4 
hardware. The “Flash Hardware Window” on page 26 will 
appear for the duration of the download and the details of 
the	 conversation	 can	 be	 viewed	 in	 the	 “Hardware 
Connection Status Window” on page 28 (advanced users 
only).

Note:	 Pressing	 any	 of	 the	 three	 buttons	 above	will	 only	
affect the Inclusion List settings	-	all	Port	Configuration	
settings	will	 remain	unaffected	as	 they	are	controlled	by	
their	own	independent	set	of	buttons.
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Please note that during this updating process, it is vital 
that	the	connection	between	Control	Centre	and	the	NDC-
4’s hardware is not interrupted. Therefore, the following 
precautions are suggested:–

1. Ensure there are no programs active/running on the PC 
other than Control Centre.

2.	Check	that	the	USB	/	RS232	cable	between	the	PC	and	
the NDC-4 hardware is secure.

3.	Confirm	that	the	battery	supply	to	the	NDC-4	hardware	
is secure.

If the Flash hardware operation is interrupted, the Port 
Configurations	could	become	corrupted.	The	user	should	
identify and remove the reason for the previous interruption 
before	 re-attempting	 to	 flash	 the	 hardware	 again	 (by	
pressing	 the	 Send	 to	 Hardware	 control	 button	 on	 the	
appropriate	tab).

The Flash Hardware window consists of four LED’s that 
indicate	the	flash	operations	current	status,	a	progress	bar	
indicating percentage completed of the current stage, and 
a	flash	program	counter	that	indicates	how	many	times	the	
NDC-4	hardware’s	Inclusion	List	has	been	re-programmed.

The Success	LED	indicates	the	final	outcome	of	the	data	
transfer. If it does not light up green, the “Hardware 
Connection Status Window” on page 28 will indicate a 
more	detailed	cause	and	the	process	should	be	performed	
again.

Flash Hardware Window
The	Flash	Hardware	window	is	displayed	for	the	duration	of	the	Port	Configuration	update	operation.

Figure 15 – Flash Hardware Control Window

Advanced Features
The	following	windows	and/or	tabs	will	only	be	of	interest	to	the	advanced	user,	as	they	are	not	vital	for	the	configuration	
of	the	NDC-4	hardware.	They	do	however,	explain	the	useful	diagnostic	and	monitoring	features	available.

These	advanced	windows	are	hidden	by	default,	and	all	novice	users	should	advance	past	this	section	to	
“Using the NDC-4 ActiPatch” on page 32.
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Control Centre Port Status Window
The	first	step	in	diagnosing	the	NMEA	system	connected	to	the	NDC-4	is	the	Control	Centre	Port	Status	window.	Which	
provides	an	overview	of	data	flow,	plus	port	and	buffer	loading	status	for	the	whole	system.

Figure 16  – Control Centre Port Status Window

The ‘Received NMEA Data’ window shows the NMEA 
sentences that are present on the selected port.

The ‘Channel’ drop-down list is used to choose what data 
is shown in the window, and what data is hidden. To view 
the	NMEA	data	being	received	by	the	NDC-4	on	its	‘OPTO 
In 1’ port, select channel NMEA Port 1.

The RS232 / USB Port shows all the sentences received 
by	the	NDC-4	on	ALL	its	NMEA	Ports	(1	to	4).	Any	$PARL	
sentences displayed are special control and status 
sentences	to	help	Control	Centre	and	can	be	ignored.
 
As	 the	NDC-4	NMEA	filtering	 is	normally	only	applied	 to	
‘OUT 1’ and the source of the displayed data is ‘OUT 0’, 
all	data	received	by	the	NDC-4	will	be	shown.	However,	it	
is	sometimes	useful	to	view	the	results	of	the	filtering	setup	
in	the	NDC-4,	and	this	can	be	achieved	by	enabling	Clone	
Mode in the RS232 / USB Port section of the ‘Port 
Configure’	tab,	see	“Clone Mode” on page 23. If ‘Clone’ 
mode	 is	 not	 normally	 required,	 don’t	 forget	 to	 disable	 it	
again	before	exiting	Control	Centre.

This window is very useful when trying to diagnose a 
problem	with	the	NDC-4	based	NMEA	system.	Contact	a	
qualified	 marine	 electronic	 installer	 if	 you	 require	 help	
understanding the NMEA data seen in this window. Two 

useful sources of NMEA 0183 information are the NMEA 
0183	information	sheet	and	NMEA	Reader	both	of	which	
are	 available	 for	 free	 on	 the	Actisense website (www.
actisense.com). NMEA Reader not only makes it easy to 
see	the	data	available	but	it	breaks	the	information	down	
in an informative way. With the option to save logs of the 
data this is a powerful diagnostic tool.

Instead	of	using	NMEA	Reader	the	displayed	data	can	be	
frozen	 /	 paused	 by	 selecting	 the	 ‘offline’ option in the 
Comms	menu	on	the	main	window.	Remember	to	re-select	
the	correct	Comm	port	to	continue	with	configuring	and/or	
monitoring the NDC-4.

The	 current	 baud	 rate	 being	
used	by	Control	Centre	 to	 talk	

to the NDC-4 hardware is displayed here.

The	 first	 pair	 of	 bars	 shows	how	much	bandwidth	 (as	 a	
percentage) the PC - NDC-4 connection (either via RS232 
or	USB)	 is	being	used.	The	Rx	bar	 indicates	how	much	
data	is	coming	from	the	NDC-4,	and	the	Tx	bar	indicates	
how	much	data	is	being	sent	to	the	NDC-4	(which	will	only	
be	active	during	‘Send to Hardware’ and ‘Get Hardware 
Information’ sessions).
The	second	pair	of	bars	can	be	ignored.

www.actisense.com
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Hardware Port Status Window

Figure 17 – Hardware Port Status Window

The Hardware Port Status window provides a more in-
depth look at port loading on the NDC-4.

‘Bytes per second’	 shows	 the	 used	 bandwidth	 (as	 a	
percentage) for each input and output port on the NDC-4, 
plus	the	combined	(Uni)	input	bandwidth	being	used	of	all	
its ports. Rx 0 and Tx 0 represent the RS232 / USB port.

The	Rx	bars	quickly	indicate	if	data	is	being	received	by	an	
input,	 and	 how	much	 bandwidth	 is	 being	 used.	 The	 Tx	
bars	show	how	loaded	the	outputs	are,	which	is	a	vital	tool	
to quickly see if the ‘slow speed’	OUT	1	(TX	1)	is	being	
overwhelmed	by	the	combined	data	from	all	inputs.

Bytes	 Filtered	 shows	 the	 percentage	 of	 bytes	 that	 have	
been	filtered	on	each	input	port.	If	filter	settings	are	active,	
the	 results	 will	 be	 visible	 here,	 indicating	 that	 sentence	
filtering	/	blocking	of	an	input	port	is	operating.

Buffer Load shows the percentage loading of each of the 
port	 storage	 buffers.	The	most	 useful	 column	 is	 the	Uni	
channel	 that	 indicates	 if	sentences	are	being	stored	and	
delayed	because	an	output	is	above	maximum	loading.
 
Note:	 If	 the	 Uni	 buffer	 reaches	 maximum	 then	
communication	 between	 Control	 Centre	 and	 the	 NDC-4	
may	be	lost.

Bytes	Dropped	shows	the	percentage	of	bytes	that	have	
been	dropped	(not	 transmitted)	after	 they	arrived	on	that	
port.	Indicates	on	what	ports	sentences	are	being	dropped	
when an output is overloaded.

Notes: 
1.	If	Delete	duplicates	is	enabled	the	deletions	will	show	in	
the Bytes dropped column.
2. Sentences that do not have start and end characters 
are	not	displayed	when	lost.	For	example,	when	the	baud	
rate of an input is set to the wrong value the start and end 
characters	will	be	unreadable.	Now	ALL	the	sentences	will	
be	dropped	but	 none	will	 show	up	 in	 the	bytes	dropped	
column.

Hardware Connection Status Window

Figure 18 – Hardware Connection Status Window

The NDC-4 hardware connection status window displays 
all	 information	 related	 to	 the	 connection	 status	 between	
Control Centre and the NDC-4’s hardware. This includes 
all handshaking and data transfer information required for 
flash	 programming	 the	NDC-4	 hardware	 during	 the	Port	
configuration	data	updates.

This information is normally only useful when speaking 
with Actisense	 technical	 support	 engineer	 and	 can	 be	
ignored at all other times.

Reset
Resets the connection status messages currently 
displayed, clearing the window.
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The NDC-4 hardware information window displays the 
information received from the NDC-4 hardware.

This information Includes:-

1. Hardware Serial ID Number
The	 unique	 serial	 identification	 number	 given	 to	 each	
Actisense	product.	This	number	 is	used	to	 identify	each	
NDC-4 unit in our records.

2. Bootloader & Main (software) Program Version
Version	numbers	of	 the	bootloader	and	Main	application	
software	programs.	If	the	Main	program’s	version	number	
is	older	 (less	 than)	 that	of	 the	currently	available	NDC-4	
ActiPatch,	 the	 latest	 NDC-4	 ActiPatch	 should	 be	
downloaded from  the Actisense	website	and	the	NDC-4	
unit updated.

3. Bootloader & Main Program Date and Time
Dates	and	times	that	the	bootloader	and	Main	Application	
programs	 where	 updated	 /	 ‘flashed’	 into	 the	 hardware’s	
memory.

4. Total Operating Time
The	total	time	that	the	NDC-4	hardware	has	been	operating	
since new.

5. ARL model code
The	Manufacturer’s	Model	ID.	Model	“10”	determines	the	
hardware as an NDC-4 module.

6. ARL Hardware Version
The	 Manufacturer’s	 hardware	 revision	 number.	 Version	
“1.00”,	 in	combination	with	the	Model	ID	“10”	determines	
that this NDC-4 is actually an NDC-A product variant.

7. Operating Mode
Current	 NDC-4	 operating	 mode	 -	 either	 ‘Combiner’	 or	
‘Autoswitch’.	 Confirms	 how	 the	 NDC-4	 is	 currently	
processing any received NMEA data.

8. Flash Program Counters
Not	used	for	NDC’s	and	will	remain	blank.

Reset
Resets the hardware information displayed and requests 
the current information from the NDC-4 hardware (thus 
refreshing the displayed information).

Hardware Information Window

Figure 19 – Hardware Info Window (NDC-4) Figure 20 – Hardware Info Window (NDC-4-ASW)
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Configuration of AIS

Figure 21 – AIS Configuration with 38400 Baud Rate

Setting up the Hardware for AIS
Control	 Centre,	 supplied	 on	 the	 CD	 (or	 available	 for	
download from Actisense website), allows a quick set-up 
for	AIS	using	the	configuration	file	included.

From the menu select ‘File → Load Configuration File’ 
and select “NDC-4 config for AIS.ini”	file	from	the	
install directory. Read the pop up and click ‘OK’.

This will change the settings for OPTO IN 2. The 
configuration	tab	will	set	38400	Baud	(AIS	requires	NMEA	
0183	HS).	The	 Inclusion	List	 is	 set	 to	block	all	AIS	data	
from	being	sent	 to	 ISO	OUT	1	which	 is	 typically	 kept	at	
4800 Baud. Filtering does not affect the USB/RS232 port, 
all	the	AIS	sentences	will	still	be	outputted	on	this	port.

Note: The use of AIS at Baud rates lower than 38400 
cannot	be	recommended	as	this	could	cause	random	AIS	
target	data	to	be	lost	in	areas	of	high	target	density.

To	enable	these	settings	on	the	NDC-4	click	on	the	‘Send 
to Hardware’	button	on	BOTH the ‘Port Configuration’ 
and ‘Inclusion List’	tabs.

The	AIS	device	 should	 then	be	 connected	 to	 the	NDC’s	
‘OPTO IN 2’ as shown in ‘Figure 21’, with any other 
talkers connected as required. The device for receiving 
the	AIS	data	(chart-plotter	or	PC)	should	be	connected	to	
‘ISO OUT 0’, or the USB port.

The	remaining	ports	can	be	re-configured	by	the	user	as	
needed using Control Centre. Refer to “Using NDC 
Control Centre” on page 18 for full detailed information on 
how to use Control Centre.
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The NDC-4-ASW Autoswitch
The Actisense	 NMEA	 Data	 Multiplexer	 /	 Combiner	 /	
Autoswitch	 (NDC)	 has	 been	 designed	with	 the	 ability	 to	
operate	as	a	Multiplexer	/	Combiner	OR	an	Autoswitch.
 
For systems that have multiple NMEA devices of an  
identical type (e.g. two GPS’s or two depth sounders), 
automatic selection of the highest priority device is 
normally a vital requirement. However, the NMEA 0183 
standard has no method of automatically switching 
between	different	devices,	so	 this	 requirement	 is	usually	
fulfilled	with	a	manual	changeover	switch:	not	a	very	good	
solution,	but	the	only	one	available	until	now.

If the NMEA data from two (or more) devices are simply 
combined	together,	the	NMEA	listener(s)	will	not	be	able	to	
differentiate	between	the	various	sources	and	will	get	very	
confused,	 often	 jumping	between	 them.	 If	 this	 creates	a	
‘jumping’	position	fix,	vessel	safety	is	seriously	affected.

The NDC-4 Autoswitch mode is the perfect solution to this 
problem	-	automatically	selecting	a	single	device	from	the	
multiple	‘same	data	type’	devices	available.
 
Autoswitch mode will automatically select the highest 
priority device from up to 4 connected input devices, with 
NMEA port 1 as the highest priority through to NMEA port 
4	 as	 the	 lowest.	 This	 creates	 a	 system	 capable	 of	
automatically selecting the next priority device if the higher 
priority device fails for one of three reasons:

• A complete failure to send any NMEA data.
• An invalid NMEA sentence checksum.
• If	the	validity	flag(s)	contained	within	the	received	NMEA	

sentence indicate that this data is not valid and should 
only	be	used	with	caution.

With	 the	 addition	 of	 two	 fully	 Baud	 rate	 configurable	
outputs	protected	by	ISO-Drive	technology,	that	can	also	
incorporate	 NMEA	 filtering	 to	 remove	 any	 unwanted	
sentences	 before	 the	 switching	 process,	 the	 NDC-4	
Autoswitch	mode	is	the	most	flexible	available.

Having	 the	 ability	 to	 filter	 out	 NMEA	 data	 before	 the	
autoswitch	 process	 can	 be	 particularly	 useful	 to	 avoid	
unwanted sentences from causing the Autoswitch to 
change input channels due to invalid data, leaving only the 
required sentences to switch on.

If	 ordered	 as	 an	 Autoswitch,	 the	 NDC-4	 will	 be	 pre-
configured	as	an	NDC-4-ASW	and	be	ready	to	work	out	of	
the	box.	Alternatively,	any	NDC-4	can	be	configured	using	
Control Centre to operate in Autoswitch mode.

Setting the NDC-4 as an Autoswitch
The	NDC-4	can	easily	be	changed	between	being	a	NMEA	
Data	 Multiplexer	 /	 Combiner	 and	 an	 NMEA	 Autoswitch	
using Control Centre.

In	 the	 ‘Port	 Configure’	 tab	 click	 on	 the	 button	 labelled	
“Change	To	Autoswitch”	 to	 change	 the	NDC’s	 operation	
mode to Autoswitch. 

Figure 22 – “Change To/From Autoswitch” message

A	warning	message	will	be	displayed,	requesting	that	the	
user	confirm	 the	 request	 to	change	 to	Autoswitch	mode.	
Selecting ‘Yes’ will automatically send the new 
configuration	to	the	unit,	and	the	NDC-4	will	now	Autoswitch	
its	inputs	instead	of	Combining	them.

To	 revert	 back	 to	 Combiner	 mode,	 click	 on	 the	 (same)	
button	(now	labelled	‘Change To Combiner’). Again, the 
user	must	confirm	the	operating	mode	change	is	required	
and	 the	 NDC-4	 will	 now	 Combine	 its	 inputs	 instead	 of	
Autoswitching them. There is no need to click the ‘Send to 
Hardware’	button,	this	configuration	change	is	automatic.
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This	 program	 is	 currently	 only	 available	 for	 Windows	
platforms	 (98/ME/NT/2000/XP),	 however,	 it	 has	 been	
proven	possible	to	use	NDC-4	ActiPatch	on	a	Mac	running	
Windows emulation software.

The NDC-4 ActiPatch window consists of a Hardware 
Connection Status	 text	 box,	 Hardware status LED’s, 
Current Version (Main ID) and New Version (Patch ID) 
text	boxes,	and	the	Program (Flash)	control	button.

The	 NDC-4	 hardware	 should	 be	 connected	 to	 the	 PC	
communications port (RS232 or USB) and if not using a 
USB	connection,	a	battery	supply	is	also	required,	as	per	
the instructions in the Connecting to a Personal Computer 
section and Figure 3 (RS232, USB and Battery connections 
diagram).

Pull-down menus
The main window has three standard pull-down menus:

File → Program the Target
This	 option	 will	 become	 active	 /	 selectable	 when	 a	
successful	 connection	 has	 been	 made	 to	 the	 ‘target’	
(NDC).	The	Program	button	 is	normally	used	to	start	 the	
reprogram	 operation,	 but	 this	menu	 option	 can	 be	 used	
instead and is included for completeness.

File → Exit
Closes the NDC-4 ActiPatch program.

Using the NDC-4 ActiPatch
The	 	NDC-4	 firmware	 can	 be	 easily	 and	 quickly	 updated	 using	 the	 	 NDC-4	ActiPatch.	 The	 program	 has	 a	 simple	
appearance,	as	the	flash	update	process	has	been	completely	automated	for	a	trouble-free	operation.

Figure 24 – NDC-4 ActiPatch Window (searching for NDC)
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Comms → Offline
If ticked then no port is open. Selecting this closes the 
currently opened port.

Comms → Comm Port 1-10
Selects the PC communications port that the NDC-4 
hardware	is	attached	to	(via	the	RS232	or	USB	cable).

ActiPatch will automatically match the NDC-4 hardware’s 
Baud rate if it has changed from the 38400 Baud default. 
This	 auto-baud	 matching	 process	 could	 take	 up	 to	 20	
seconds to achieve. The result of this automatic feature is 
that the user does not need to select the Baud rate.

Once	a	Comms	port	has	been	selected	(or	 remembered	
from a previous session), ActiPatch will immediately 
attempt to connect to the attached NDC-4 hardware - no 
further user action is required until the successful 
connection	has	been	made.

Help → Help with reprogramming
Displays	 a	window	with	 useful	 information	 about	 how	 to	
perform the reprogramming operation if the user cannot 
reference this more complete support document.

Help	→	About:
Displays	the	NDC-4	ActiPatch’s	software	version	number	
and the Actisense contact information.

Buttons, LED’s and Displays

Connection Status Text Display
Displays all handshaking and data transfer information 
required	 for	 flash	 programming	 the	 NDC-4	 hardware	
during	 the	firmware	update	process.	For	most	users	 this	
information	can	be	ignored,	and	will	only	be	useful	if	there	
are	problems	in	re-flashing	the	attached	NDC-4.

Serial ID (unique identification number)
Displays the Serial ID of the NDC-4 that is attached and 
successfully connected to. Every Actisense product has 
its	own	unique	serial	identification	number.

Main ID (current version)
Displays	the	version	of	firmware	currently	resident	 in	 the	
NDC-4 hardware’s Flash memory. This information is 
received from the NDC-4 hardware when ActiPatch 
detects the NDC-4 hardware’s presence.

Patch ID (new version)
Displays	 the	 version	 of	 firmware	 that	 ActiPatch	 can	
upgrade	 the	 NDC-4	 hardware	 to.	 This	 number	 must	
normally	be	greater	than	the	Main	ID	(current	version)	for	
an	update	to	be	required.

If the Patch ID (new version) is older or equal to the 
Current Version, then ActiPatch will display a warning 
message	that	must	be	acknowledged	before	 the	re-flash	
operation	can	begin.

Figure 23 – “Hardware already up to date” message

There	 is	 normally	 nothing	 to	 be	 gained,	 and	 perhaps		
functionality	and	performance	of	 the	NDC-4	 to	be	 lost,	 if	
an	older	firmware	version	is	used	to	reprogram	the	NDC-4.	
However,	 for	 rare	 occasions	 when	 instructed	 by	 an	
Actisense	 support	 engineer,	 this	 ‘stepping	 back’	 of	 the	
firmware	can	be	achieved.



 

Page 34© 2015 Active Research Limited

Connection Status LED’s
The four status LED’s inform the 
user what stage the reprogramming 
operation is currently at.
 
Initially	no	LED’s	will	be	lit.	Once	a	
successful connection is made to 
an NDC-4 unit, the Connected LED 
will light. During the reprogramming 
operation,	 both	 the	 Erasing	 and	

Programming	LED’s	will	become	lit,	and	finally,	once	the	
operation is complete, the Success LED with light. It is 
normal for the success LED to only stay lit for a second or 
two, after which it will turn off.

Data Communication LED’s
These LED’s indicate if any data 
communication to the NDC-4 (Tx) 
and from the NDC-4 (Rx) is 
happening. They are very useful in 
helping to diagnose simple 
connection issues.

Program Command Button
Becomes	available/selectable	once	
connection to an NDC-4 unit is 
achieved.	 This	 button	 Initiates	 the	
flash	update	of	the	NDC-4	hardware.	

At this point the diagnostic LED on 
the	NDC-4	will	be	solid	red.

The Reprogramming Operation
Once	 the	 program	 button	 has	 been	 pressed,	 the	
reprogramming	 operation	 cannot	 (and	 must	 not)	 be	
stopped and must complete successfully - otherwise the 
NDC-4	hardware	will	become	unusable.

The user must take all precautions to prevent loss of 
battery	 power	 to,	 or	 communications	with	 the	NDC-4.	 If	
there	 is	 a	 failure,	 the	 reprogramming	 operation	must	 be	
restarted	-	once	the	original	issue	has	been	removed.

Progress Bar
During	the	reprogramming	operation	the	progress	bar	will	
be	visible.	This	indicates	how	much	of	the	two	stages	has	
been	completed	and	how	much	is	left	to	do.

During	the	Erasing	operation,	 the	bar	 is	red	showing	the	
Flash	memory	being	erased	(cleared).

During	the	Programming	operation,	the	bar	is	green	(with	
a	 red	 background),	 showing	 the	 new	 firmware	 being	
written	to	the	flash	memory.	Once	the	green	progress	bar	
reaches	 the	 far	 right	 hand	 side,	 the	 operation	 will	 be	
complete and the Success LED will light for a second or 
two.

The	successful	completion	of	the	firmware	update	process	
can	be	further	checked	by	looking	at	the	ID	display	area.	
The Main ID (Current Version) and the Patch ID (New 
Version)	 will	 now	 be	 identical	 -	 proving	 that	 the	 new	
firmware	is	now	safely	inside	the	NDC-4.

The	USB	cable	is	not	vital	to	the	configuring	or	updating	of	
an NDC-4; Port 0 (OPTO IN 0 and ISO OUT 0) connected 
to an RS232 port can perform exactly the same operations 
if	a	USB	cable	is	not	available.
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Troubleshooting Guide
This	guide	will	concentrate	on	all	relevant	troubleshooting	issues	above	simple	cable	connection	faults.	Therefore,	the	
cables	between	the	NDC-4	hardware	and	any	other	devices	should	be	checked	as	a	matter	of	course,	before	continuing	
with this guide.
 

Diagnostic LED
The NDC-4 hardware supports a tricolour diagnostic LED that indicates the current operating mode of the hardware, or 
if	an	error	has	been	detected	during	the	self-test	initiation	process.	‘Table 1’ details what each LED colour represents 
and if any user interaction is required.

LED Colour /
Flash Count

Mode / Error condition Required User Response

Start up operation modes
The	sequence	below	indicates	a	successful	power-up	of	the	

NDC-4 with no data on any of the input channels.

LED is off Power down mode
The	NDC-4	has	no	power,	confirm	the	battery	is	connected	

correctly.	For	USB	powered	units,	ensure	the	cable	is	
connected and the USB drivers are installed.

Red, 
No	flashing

Start-up mode,
No error

No response required. A normal operation mode that should 
last for no more than 1.5 seconds. Any longer indicates an 

error with the main program.

Amber,
No	flashing

Initialise and self-test mode,
No error

No response required. A normal operation mode that follows 
after the Start-up mode and should last for approximately 1 

second.

Green,
No	flashing

Normal and no data mode,
No error

No response required. A normal operation mode that follows 
the Initialise and self-test mode. Indicates that no error was 

detected during the self-test operation. 

Also	indicates	that	no	data	is	currently	being	received	by	the	
NDC-4 hardware.

Running modes
Below	are	the	other	correct	operating	modes	possible	with	the	

NDC-4.
Green,

Flashing (1-10 per 
second)

Normal and data Rx mode,
No error

No response required. A normal operation mode that indicates 
that	data	is	currently	being	received	(on	at	least	one	channel)	
by	the	NDC-4	hardware.	Flash	rate	proportional	to	Rx	rate.

Red, 
No	flashing

Flash updating mode,
No error

No response required. LED will stay red for the duration of the 
flash	update	operation	(using	Actipatch).	Once	operation	
complete,	NDC-4	hardware	will	be	automatically	reset.

Error mode
Below	is	a	possible	error	mode	for	the	NDC-4.	If	the	error	

persists see “Returns Procedure” on page 44. 

Amber,
Flashing (Once 

every 4 seconds)

Error trap mode,
EEPROM memory error

An	error	with	the	EEPROM	memory	has	been	detected	during	
the self-test mode.

Reset the NDC-4 hardware.

Table 1 – Diagnostic LED Colours
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Control Centre Error Status Window
Control Centre will display any error information received from the NDC-4 hardware in a window like that in “Figure 25 
– Control Centre Error Status Window”. If this window is displayed, follow the message instructions carefully and 
then if the fault persists, contact Actisense (refer to “Company Information” on page 44).

Figure 25 – Control Centre Error Status Window
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Diagnosing the NDC Control Centre Connection
To	diagnose	an	 installation	with	an	NDC-4	 is	best	done	with	NDC	Control	Centre.	The	first	stage	of	 this	 is	 to	have	
Control	Centre	connect	with	the	NDC-4.	If	this	connection	is	not	being	made	follow	this	flow	chart	starting	at	the	blue	box	
(top left) and answer the questions to reach the recommended solution.

Solution A: Battery Connection
1.	Check	the	polarity	of	the	battery	connection.
2.	Check	the	battery	connection	is	secure.
3.	Check	the	battery	is	supplying	8-35	volts.

Solution B: USB Connection 1
1.	 Check	 the	 USB	 cable	 is	 connected	 securely	 at	 both	
ends.
2. If there is an unknown device listed in the USB or Port 
list	 the	 drivers	 need	 to	 be	 installed.	 See	 “USB Driver 
Installation” on page 12.

Solution C: USB Connection 2
The	unit	may	be	faulty.
1.	Remove	the	USB	cable	and	connect	battery	power	 to	
prove the LED is faulty.
2.	 With	 the	 USB	 cable	 connected	 continue	 to	 test	 the	
connection as if the LED was green.
If	 the	problem	persists	 follow	 the	“Returns Procedure” 
on page 44.

Solution D: RS232 Connection 1
Ensure the port 0 to RS232 connection is wired correctly 
and securely. See “Figure 26 - DB9 Connection” or see 
“Other Connections” on page 11.

Solution E: RS232 Connection 2
If all the other solutions listed do not allow Control Centre 
to connect to the NDC-4 please contact us for further 
instructions, see “Company Information” on page 44.

Solution F: Port Selection
To	change	the	port	number	follow	“USB Configuration” 
on page 14, this method also applies to non-USB serial 
connections.

Solution G: Baud Rate Selection
The	auto	Baud	rate	facility	is	not	being	successful.	It	can	
take up to 12 seconds for this feature to complete. If after 
12 seconds the connection is still not made see “Low 
Baud Rate Warning” on page 22.

5 14 3 2

Figure 26 - DB9 Connection

Note: Wire colours
are for guidance only.
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Diagnosing Data flow using NDC Control Centre
NDC	Control	Centre	provides	plenty	of	useful	information	to	help	debug	data	flow	problems.	Here	we’ll	go	through	some	
simple methods of checking data and solving various issues such as data loops and overloading.

Problem: No data received on input
The	 best	 way	 to	 check	 an	 input,	 is	 to	 use	 the	 Control	
Centre Port Status window and Hardware Port Status 
window (select these from the window drop down menu). 
Refer to “Control Centre Port Status Window” on page 
27 and “Hardware Port Status Window” on page 28.

Test:
Look at the ‘filtered’ column in the ‘Hardware Port 
Status’ window “Figure 27 - Filtered Port Status”, is 
there	any	bars	showing?	If	filtering	is	enabled	on	this	input	
channel then this could stop all your data.

Solution:
Disable	the	inclusion	list	for	this	input	channel	and	‘Send 
to Hardware’ see “Inclusion List Configuration Tab” 
on page 24.

Test:
In the ‘Control Centre Port Status’ window, select the input 
channel	that	you	are	having	trouble	with	from	the	channel	
drop	 down	menu.	 If	 no	 data	 is	 being	 displayed	 then	 no	
data	is	being	received.

Figure 27 - Filtered Port Status

Figure 28 - Nonsense Sentences

Test:
If the ‘Control Centre Port Status’ window is showing 
nonsense “Figure 28 - Nonsense Sentences” then the 
baud	rate	is	incorrect	for	this	channel.

Solution:
Refer	to	the	manual	of	the	talker	device	to	find	the	output	
Baud	rate.	Change	the	baud	rate	in	the	main	window	for	
the input channel to the same as the talker device and 
click ‘send to hardware’. Refer to “Changing Baud 
Rates for Each Port” on page 22.

Solutions:
1. Check the input device is switched on and set-up to 
output data.

2. Check the wiring is correct and secure. Each of the 
NDC-4’s inputs require 2 wires, a ‘Data’, ‘A’ or ’+’ wire 
and a ‘Ground’, ‘B’ or ‘-’ wire. Only use ground if there is 
no ‘B’ or ‘-’ wire.
Refer to the user manual of the input device for its wiring 
configuration.	To	 confirm	 the	NDC-4	 connection	 refer	 to	
“Connecting to NMEA Devices” on page 10.
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Test:
Looking at the Bytes dropped column “Figure 29 - 
Overloaded Port Status”	confirms	that	the	sentences	are	
being	discarded	by	the	NDC-4.	Next	look	at	the	‘Bytes per 
second Tx’	column,	it	can	be	seen	that	Tx	1	is	overloading	
while	Tx	0	is	not.	 If	all	 the	inputs	are	the	same	(4800	by	
default) then the total percentage in should not exceed 
100%	for	the	same	output	baud	(default	4800	for	Out	1).	In	
this	example	the	total	is	about	110%	for	the	3	active	inputs.	
Of	course	if	one	of	the	inputs	is	set	to	a	higher	baud	rate	
than	the	output	then	there	is	a	high	probability	that	there	
will	 be	 overloading.	 This	may	 not	 always	 show	 as	 over	
100% when the inputs are added together. For example 
with	AIS	at	38400	baud	anything	over	about	12.5%	loading	
of the input would start to overload a 4800 output. However, 
there are times when using a 38400 input and a 4800 
output can work, a Chartplotter outputting waypoint data at 
38400 to an autopilot at 4800 shouldn’t have a load that is 
too great.

Solutions:
1.	Change	the	output	baud	to	a	higher	rate,	some	devices	
are	 configurable	 to	 accept	 higher	 baud	 rates	 for	 their	
inputs	and	 this	will	provide	enough	bandwidth	 for	all	 the	
combined	data.

2.	 If	 it	 is	not	possible	 to	 increase	 the	baud	rate,	deleting	
sentences that give the same information can help, see 
“Delete duplicates” on page 23.

Note:	When	Delete	duplicates	is	Enabled	and	sentences	
are	deleted	because	of	this	rule,	they	will	still	show	in	the	
Bytes Dropped column of the Hardware Port Status 
window.

3.	 If	 sentences	 are	 still	 being	 dropped	 (other	 than	 the	
deleted duplicates), choosing the sentences that are 
dropped	 from	 the	 Inclusion	 List	 is	 preferable	 to	 random	
losses, refer to “Inclusion List configuration tab” on 
page 24. 

Start	by	allowing	only	the	sentences	that	are	needed	from	
each input and see what effect this has on the output load. 
If	there	is	a	good	amount	of	bandwidth	left	then	add	some	
of	the	desirable	sentences	as	well.

4.	When	filtering	is	not	enough	to	prevent	sentences	being	
dropped change the port priority list to reduces losses 
from the critical inputs see “Changing the port priorities” 
on page 23.

Problem: Control Centre Port Status window 
ignores filtering
By default the ‘Inclusion List’ is only applied to OUT 1 
and since the ‘Control Centre Port Status’ window only 
shows	 data	 available	 on	 OUT	 0	 (USB/RS232)	 this	 is	
normal.

Solution:
Enable	‘Clone Mode’, this will apply the ‘Inclusion List’ 
to BOTH	 outputs	 to	 change	 the	 data	 available	 to	 be	
displayed in the Control Centre Port Status window.

Note:	Remember	to	disable	‘Clone Mode’	once	debugging	
has	been	completed.

Figure 29 - Overloaded Port Status

Problem: Missing data from input
Using the Hardware Port Status window will help work out 
where	 and	 why	 data	 is	 being	 lost.	 Refer	 to	 “Hardware 
Port Status Window” on page 28.
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Specifications
The	NDC-4	ISO-Drive	output	is	a	very	flexible	output	that	is	RS485,	RS232,	RS422	and	NMEA	0183	compatible.

Parameter Conditions Min. Max. Unit

Supply

Supply voltage External power supply 8 35 V

Supply current from external source 
(see note 1)

Supply voltage = 12v 30 40 mA

Supply voltage = 24v 15 20 mA

Supply voltage USB powered 4.75 5.25 V

Supply current from USB (see note 1) Supply voltage = 5v 67 75 mA

Opto-isolated Flexible Input

Input	voltage	between	+/-
Logical	‘1’/stop	bit -15.0 0.5 V

Logical	‘0’/start	bit 4.0 15.0 V

Input current
Maximum is under +35v overload 
condition, Min @ 2.0v input level

1.6 9.0 mA

Differential input voltage Required	level	for	NMEA	to	be	detected 1.8 2.0 V

Galvanic isolation Between input & output 2500 V

Overdrive protection 40 V

Input Baud rate (ports 0 & 1 + USB) Configurable	Baud	rate 4800 115200 bps

Input Baud rate (ports 2 & 3) Configurable	Baud	rate 4800 57600 bps

Input Baud rate (port 4) Fixed Baud rate 4800 4800 bps

ISO-Drive Flexible Output

Output	 voltage	 between	 ISO	Out	 +/A	 and	
ISO Out -/B (under no load)

Logical ‘1’ -4.6 -5.0 V

Logical ‘0’ 4.6 5.0 V

Output current at max load of 100 ohm
At maximum load, differential drive 
voltage reduces to 2.1v

- 21 mA

Output short circuit current (note 2) Due to short circuit protection 50 55 mA

Galvanic isolation From Opto input and (USB) ground 1500 V

Output Baud rate (ports 0 & 1 + USB) Configurable	Baud	rate 4800 115200 bps
Data propagation delay Under no-overload conditions 1.0 100 ms

General

Ambient	temperature -20 +70 °C

Guarantee Extended Actisense guarantee - 3 Year

Gland clamping range Cable	diameters	accommodated 4.5 10 mm

IP Rating IP66

Table 2 – NDC-4 Specifications

All	specifications	are	taken	with	reference	to	an	ambient	temperature	(TA)	of	+25°C.

Notes:
1. Current consumption measured under no-load conditions.
2.	Short	circuit	may	be	applied	 indefinitely.	The	 ISO-Drive	output	may	be	short-circuited	directly	 to	a	30	volt	battery	
supply	without	damage.	A	maximum	current	of	50mA	will	flow	due	to	“polyfuse”	auto-resetting	fuse	technology	being	
used in each output.
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System Block Diagrams

Figure 30 – NDC-4 in ‘Combiner’ Mode Signal Flow Block Diagram

Figure 31 – NDC-4 in ‘Autoswitch’ Mode Signal Flow Block Diagram
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Save your NDC-4 configuration options here

OPTO IN (1-4) - NMEA Devices Connected Baud Rate

USB / RS232 (bi-directional port) or OPTO IN 0 - Device Connected Baud Rate

ISO OUT 0  - NMEA Devices Connected Baud Rate

ISO OUT 1  - NMEA Devices Connected Baud Rate
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Company Information 

Active Research Limited
5, Wessex Trade Centre
Ringwood Road
Poole
Dorset
UK
BH12 3PF

Telephone:  01202 746682  (International : +44 1202 746682)

Actisense	on	the	Web:	For	advice,	support	and	product	details

E-mail:   support@actisense.com
Website:  www.actisense.com

Twitter:   www.twitter.com/ActisenseNews (Actisense News and Product Updates)
   www.twitter.com/ActisenseTech (Actisense Product Updates)
Facebook:  bit.ly/actibook    (Actisense News and Product Updates)
LinkedIn:  linkd.in/actisense   (Actisense News and Product Updates) 

“Actisense” is a registered trademark of Active Research Limited.

Order Codes
NDC-4 5 isolated inputs (4 NMEA HS), 2 ISO-Drive outputs

NDC-4-USB 4 isolated inputs (3 NMEA HS), USB In & Out and 2 ISO-Drive outputs

NDC-4-AIS NDC-4 base unit pre-configured for AIS

NDC-4-AIS-USB NDC-4-USB unit pre-configured for AIS

NDC-4-ASW NDC-4 base unit pre-configured as an Autoswitch

Returns Procedure
Actisense prides itself on having a very low product return rate. In the unlikely event that you need to return a unit for 
repair, it is important to follow these steps.

1. Download and install the latest Firmware version and Control Centre software from www.actisense.com.
2. Read through the “Troubleshooting Guide” on page 35	to	see	if	your	problem	has	a	simple	solution.
3. Contact Actisense Tech Support	at	the	email	address	below	for	further	support	and	an	RMA number.

To qualify for an RMA number	you	will	need	to	provide	the	serial	number,	date	of	purchase	and	where	you	purchased	
the	unit	from.	You	will	be	asked	to	confirm	the	above	steps	have	been	attempted	and	the	nature	of	the	fault.

Any units returned without an RMA number will incur a delay in processing and may result in a charge dependant on 
the guarantee status of the unit.

mailto:support%40actisense.com?subject=NDC-4%20manual%20help
www.actisense.com
http://www.actisense.com
www.actisense.com
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